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1. Obijetivos de la practica

Los objetivos de esta practica son los siguientes:

» Familiarizacién con el ordenador y los elementos basicos de un sistema operativo.
= Familiarizacién con el entorno de desarrollo Processing.
= Familiarizacion con aspectos basicos de programacién a través de programas en Processing.

2. Processing

2.1. Introduccion

Processing es un lenguaje de programacion y un entorno de desarrollo (Integrated Development
Environment, IDE).

Basado en Java.

Produccién de proyectos multimedia e interactivos.
Creado por cientificos del MIT en 2001.

Distribucion gratuita y de c6digo abierto.

La propia pagina de Processing muestra numerosos ejemplos de proyectos realizados con este
lenguaje. También hay muchos ejemplos en Youtube, en particular, en el canal de The Coding
Train.

Figura 1: Visualizacidn del fractal de Mandelbrot.


https://processing.org/examples/
https://www.youtube.com/c/TheCodingTrain
https://www.youtube.com/c/TheCodingTrain
https://processing.org/examples/mandelbrot.html
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Figura 2: Canal de Youtube The Coding Train.

2.2. El entorno de desarrollo

El entorno de desarrollo de Processing tiene un disefio minimalista que facilita su uso. La interfaz

grafica estd compuesta por los siguientes elementos principales:

Un ment de opciones (archivo, editar, sketch, depuracién, herramientas y ayuda).
Dos botones para ejecutar y detener el programa.

= Un drea central para escribir el c6digo fuente (editor).

Una ventana inferior donde se muestran dos pestafias:

e Consola: salida estdndar del programa.
o Errores: mensajes de error generados durante la ejecucion.

Al ejecutar un programa se abrird una nueva ventana donde se mostrara el resultado de la

ejecucion.

[ ) welcome to Processing 4 = [u]

If you're new to Processing, start with an example:

Mouse interactionsin 2D Mouse Arc Tangent

Flocking Rotating Arcs in 3D

Run the example; watch what happens. Modify the code.
Select a keyword and navigate to Help » Find in Reference
to learn about it. Open File > Examples for hundreds more.

If this is your first time using a 4.0 release, you can
read about what has changed since 3.0 and earlier
releases.

Orif you're familiar with 40, you can read about
revisions and updates in recent 4.0 releases.

The function Line(int, int, int, int) does not exist

Be sure to visit Tools > Theme Selector to choose your
own color scheme for the environment. Not fond of
sketch_220809a? You can also select an alternate sketch
naming method in the Preferences window.

Show this message on startup Get Started

Figura 3: Vista del entorno de desarrollo (derecha) y ventana pop-up (izquierda) que redirige a ejemplos disponibles

en su pagina web.


https://www.youtube.com/c/TheCodingTrain
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Advertencia

El primer archivo que se crea en un nuevo proyecto de Processing se denomina
sketch_yymmdda. Es recomendable cambiar el nombre del archivo para que tenga senti-
do con el programa que se va a desarrollar. Ademas, al guardarlo nos preguntard el nombre
del proyecto, que también es recomendable que tenga sentido.

Indicad una ubicacién de facil acceso en vuestro ordenador para guardar los proyectos de
Processing.

3. Dibujando figuras geométricas

Las figuras geométricas se dibujan en una ventana que estd formada por una matriz de pixeles.
Cada pixel es un pequefio punto de luz que puede tener un color diferente. La combinacién de
todos los pixeles forma la imagen que vemos en la pantalla.

Un pixel es la unidad mds pequefia de una imagen digital. La resolucién de una imagen se
refiere a la cantidad de pixeles que contiene, y se expresa como el ntimero de pixeles en el eje
horizontal por el ntimero de pixeles en el eje vertical (por ejemplo, 1920x1080 pixeles). Por ejemplo,
la Figura 4 muestra una animacién con una resolucién alta, donde los pixeles no son visibles a
simple vista. En cambio, en la Figura 5 se ha reducido la resolucién de la animacién, y comienzan
a ser visibles los pixeles individuales.

Figura 4: Fotograma de una animacién con una resolucién de pantalla alta.

Figura 5: Fotograma de una animacidén con una resolucion de pantalla mas baja, donde comienzan a ser visibles los
pixeles.

Para dibujar cualquier figura geométrica, es necesario especificar una o varias posiciones en la
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ventana. Dichas posiciones se definen mediante un par de coordenadas (x, y), donde x indica la
posicién horizontal e y la posicién vertical. En Processing, el origen de coordenadas (0,0) se
encuentra en la esquina superior izquierda de la ventana, como se muestra en la Figura 6.

Ejercicio 1 - Sistema de coordenadas

Dibuja una linea que va desde la posicién (10, 0) hasta la posicién (40, 50). Cuando se ejecute,
os podréis dar cuenta de que el origen, (0,0), parte de la esquina superior izquierda.

line (10, 0, 40, 50);

6 px

0,0 0,5

b,

3,3

6 px

2,2

1,1

5,0

Figura 6: llustracion de una matriz de pixeles, indicando las coordenadas de algunos de ellos.

Este concepto puede entenderse como darle un nombre a un conjunto de instrucciones para
poder reutilizarlas facilmente mas adelante. En matematicas, una funcién toma uno o varios
valores de entrada y produce un valor de salida siguiendo una regla. Por ejemplo, la funcién
f(x) = x? toma un nimero z y devuelve su cuadrado.

En programacién ocurre algo muy similar: una funcién recibe unos parametros, ejecuta unas
instrucciones con ellos y, opcionalmente, devuelve un resultado.

Por ejemplo, podemos definir en Java una funcién que reciba un ntimero entero y devuelva su
cuadrado:

int square (int x) {

return x * x;

Una vez definida, podemos usar la funcién tantas veces como queramos, simplemente indicando
el valor de entrada:

int result = square(5); // result tendrd el valor 25

De este modo:

m square es el nombre de la funcién.
= x es el pardmetro de entrada.
» return indica el valor que devuelve la funcién.

En Processing ocurre exactamente lo mismo. La funcién 1ine, por ejemplo, recibe cuatro parametros
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(las coordenadas de dos puntos) y ejecuta una accién: dibujar una linea en la ventana. La diferencia
es que, en este caso, la funcién no devuelve un valor, sino que produce un efecto visual en
pantalla.

Ejercicio 2 - Errores comunes

Prueba a copiar el siguiente c6digo en el editor de Processing y ejecutarlo:
Line (10, 0, 40, 50);

Solucién:

Processing es sensible al uso de maytsculas y mintisculas. Por ejemplo, la funcién para
dibujar una linea es 1ine, NoO Line ni LINE.

Las palabras reservadas se muestran resaltadas en el editor, por lo que esta es una manera
de ver si el nombre de una funcién esta bien escrito. Los errores se muestran en la pestafia
Errores de la ventana inferior.

Ejercicio 3 - Multiples formas geométricas

Prueba a dibujar varias lineas en diferentes posiciones de la pantalla, utilizando la instrucciéon
line varias veces.

3.1. Lienzo

Las figuras geométricas se dibujan sobre un lienzo de tamafio predeterminado 100x100 pixeles.
No obstante, es posible cambiar el tamafo del lienzo utilizando la funcién size, que recibe dos
pardmetros: el ancho y el alto del lienzo en pixeles.

Ejercicio 4 - Tamafio del lienzo

Dibuja varias lineas en un lienzo de tamafio 300x200 pixeles.

Solucién:
size (300, 200);
line (10, 0, 40, 50);

line (100, 50, 200, 150);

(
(
(
line (250, 0, 250, 200);

3.2. Tipos de figuras geométricas

Ademas de la linea utilizada en los ejercicios anteriores, Processing permite dibujar otras figuras
geométricas bésicas, tales como puntos, tridngulos, cuadrilateros, rectingulos y elipses.

Ejercicio 5 - Deduccién de parametros

(Puedes deducir qué pardmetros son necesarios para dibujar algunas de las figuras geomé-
tricas mencionadas anteriormente? Puedes consultar la documentacion oficial de Processing,
y mas concretamente, la seccion 2d primitives en el apartado Shape.

Solucién:



https://processing.org/reference#shape
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® point (x, y):un punto en la posicién (x, y).

» triangle(xl, yl, x2, y2, x3, y3):un tridngulo con vértices en las posiciones (x1,
y1), (x2,y2) y (x3,y3).

® quad(xl, yl, x2, y2, x3, y3, x4, y4):un cuadrilatero con vértices en las posicio-
nes (x1,y1), (x2,y2), (x3,y3) y (x4, y4).

® rect(x, y, anchura, altura):unrectdngulo con esquina superior izquierda en la
posicién (x, y), de anchura y altura especificadas.

m ellipse(x, y, anchura, altura):una elipse centrada en la posicién (X, y), con an-
chura y altura especificadas.

3.2.1. Dibujando rectangulos y elipses

Tanto en la documentacién oficial, como en la solucién del ejercicio anterior, os habréis podido dar
cuenta de que las funciones rect y ellipse requieren cuatro pardmetros: dos para la posicién
y dos para el tamafio. Sin embargo, hemos asumido que la posicién siempre corresponde a la
esquina superior izquierda del rectdngulo o al centro de la elipse. Esta suposicién es correcta
por defecto, pero es posible cambiarla utilizando las funciones rectMode y ellipseMode. Mds
concretamente, estas funciones permiten definir cémo se interpretan las posiciones pasadas como
pardmetros a las funciones rect y ellipse. Existen dos modos principales para cada una de estas
funciones:

= CORNER: la posicién corresponde a la esquina superior izquierda del rectdngulo o elipse.
= CENTER: la posicién corresponde al centro del rectangulo o elipse.

o
rectMode (CORNER) rectMode (CENTER) ellipseMode (CORNER) ellipseMode (CENTER)
rect(x,y,w,h) rect(x,y,w,h) ellipse(x,y,w,h) ellipse(x,y,w,h)
Opcion por defecto Opcion por defecto

Figura 7: Representacion de cdmo se interpretan las posiciones en ambos modos para rectangulos y elipses.
Por defecto, Processing interpreta las posiciones de la siguiente manera:

rectMode (CORNER) ;
ellipseMode (CENTER) ;

También es posible cambiar esta interpretacién usando:

rectMode (CENTER) ;
ellipseMode (CORNER) ;

Ejercicio 6 - Modo de dibujo

Intenta dibujar un circulo centrado en (20, 30) con radio 10 utilizando ambos modos. En el
siguiente c6digo tienes todas las instrucciones necesarias para completar el ejercicio:
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// Modo por defecto
ellipseMode (CENTER) ;
ellipse( , , , );

// Modo alternativo
ellipseMode (CORNER) ;
Qlildpsel , » o )§

4. Color en Processing

4.1. Escala de grises

Hasta ahora, hemos dibujado figuras geométricas sin especificar ningtin color. Por defecto, las
figuras se dibujan en negro sobre un fondo blanco.

A continuacién, veremos cémo especificar colores en Processing. Por ahora, basta con componer
colores en escala de grises. Para ello hay que tener en cuenta que la escala de un tono de gris va
de 0 a 255; el valor 0 corresponde al negro y el valor 255 corresponde al blanco. Por ejemplo, la
figura de la derecha se ha representado tinica y exclusivamente con diferentes valores de gris.

En Processing, las figuras tienen borde y relleno, que se definen mediante los métodos stroke y
fi11. Ademads, también puede controlarse el color de fondo de la ventana con background.

] 255

0

Figura 8: Imagen representada unicamente con valores de gris.

Por ejemplo, podemos definir el color del fondo, asi como del borde y el relleno de un rectdngulo
de la siguiente manera:

background (0) ; // fondo
stroke (200) ; // borde
fi11(100) ; // relleno

rect (50, 50, 100, 100);

Ademés, cabe destacar que Processing funciona como una maquina de estados; es decir, una vez
se indica el color de borde o de relleno, este se utilizara para todas las figuras que se dibujen a
continuacién. Por ejemplo, podemos dibujar dos rectangulos con el mismo color de borde, pero
diferente color de relleno, de la siguiente manera:
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stroke (0) ;

£i11(150) ;

rect (20, 20, 50, 50); // borde negro, relleno gris

fill (50) ;

rect (80, 20, 50, 50); // mismo borde, diferente relleno

Ejercicio 7 - Circulo y colores

Dibuja un circulo negro con borde gris, centrado en (20, 30) y con radio 10.
Solucién:

stroke (128) ;
fill (0) ;
ellipse (20, 30, 20, 20);

Intenta crear un lienzo de tamafio 30x30 y repite este ejercicio. ;Qué sucede ahora?

Ejercicio 8 - Dibuja una forma geométrica

Trata de obtener algo parecido a la figura que se muestra debajo.

4.2. Colores RGB (red, green, blue)

Ademads de diferentes tonos de gris, Processing permite definir colores a partir de los tres colores
primarios: rojo, verde y azul (RGB). Cuando los tres componentes toman el valor maximo (255),
el color resultante es el blanco. En una escala de grises, los tres valores RGB coinciden; por ejemplo,
el color (0, 0, 0) corresponde al negro. Por otro lado, si s6lo activamos un canal con 255, y dejamos
el resto a 0, obtenemos rojo, verde o azul.

fill (255, 0, 0); // rojo
fill (0, 255, 0); // verde
fi11 (0, 0, 255); // azul

Ejercicio 9 - Colores RGB
¢(Sabrias decir qué colores crearan las siguientes combinaciones de rojo, verde y azul?

m fill (255, 255, 0)
m fi11(0, 255, 255)

10
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Figura 9: Representacion de los colores primarios RGB.

fi11 (255, 0, 255)

fi11 (255, 255, 127)
fi11(127, 255, 255)
fi11 (255, 127, 255)

Pista: fijate en la Figura 9.

| [ Selectorde color
|

R 137

@
(53]
(7S]
Es

G 84

B 84

#895454

Copiar
L )

Figura 10: Captura de pantalla del selector de color de Processing.

Como habréis podido observar a partir del Ejercicio 9, no es sencillo imaginar qué color genera
una mezcla concreta de valores RGB, ni determinar qué valores exactos u aproximados de rojo,
verde y azul necesitamos para componer un color que tengamos en mente. Por esta razén, Pro-
cessing dispone de una herramienta, Selector de color, que permite interactuar con una paleta
de colores y obtener valores de rojo, verde y azul. Podéis acceder a esta herramienta desde el
ment Herramientas > Selector de color. También podéis probar el selector que se muestra en la
Figura 9, que es una implementacién web de un selector de color similar al de Processing.

4.3. Opacidad

Ademés de los canales R, G y B, también podemos indicar un valor de opacidad. De esta manera,
un valor de opacidad de 255 indica que elemento a dibujar es completamente opaco, y un valor
de 0 indica que es completamente transparente. Para especificar la opacidad, bastante con indicar
un cuarto valor en operaciones como stroke 0 fill.

11
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fill (255, 255, 127);
rect (50, 50, 100, 100); // rectangulo opaco

fill (255, 0, 127, 127);

rect (20, 20, 50, 50); // rectangulo semitransparente

5. Programas dinamicos

Hasta este momento, hemos escrito programas estéticos, es decir, programas que dibujan una
imagen fija. A continuacion, veremos cOmo crear programas dindamicos que pueden cambiar con
el tiempo.

Comenzaremos con este bloque de c6digo:

size (600, 600);

// Fondo blanco
background (255) ;

// Coordenadas desde el centro
ellipseMode (CENTER) ;
rectMode (CENTER) ;

// CUERPO
stroke (0) ;
fill (150) ;
rect (200, 260, 50, 260);

// CABEZA
fill (255) ;
ellipse (200, 160, 130, 160);

// 0J0S
fill (0) ;
ellipse (170, 160, 30, 60);
ellipse (230, 160, 30, 60);

// PIERNAS
stroke (0) ;
line (175, 390, 150, 420);
line (226, 390, 250, 420);

Ejercicio 10 - Dibuja a Zoog

Intenta dibujar al alienigena Zoog utilizando el bloque de c6digo anterior como referencia.

5.1. Comentarios

Aprovechando que nuestro programa empieza a ser un poco mds largo, es recomendable afiadir
comentarios para explicar qué hace cada parte del c6digo. En Processing, los comentarios se indican
con // para comentarios de una sola linea, o con /* y */ para comentarios multilinea. Ademas
de para indicar qué hace una parte de nuestro c6digo, también se pueden usar para desactivar

12



Informatica (30717) 5 Programas dindmicos

Figura 11: Imagen del alienigena Zoog.

13
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temporalmente lineas de c6digo durante la depuracién. Por ejemplo, en el siguiente cédigo se
han afiadido comentarios para explicar qué parte del cuerpo de Zoog dibuja cada bloque de
instrucciones, y para desactivar el dibujo de la cabeza temporalmente:

// Dibuja el cuerpo de Zoog
rect (200, 260, 50, 260);

/* Dibuja la cabeza de Zoog en la posicidén (200, 140) con ancho y alto 120 */
//ellipse (200, 160, 130, 160); // Desactivado temporalmente

// Dibuja los ojos de Zoog
/*ellipse (170, 160, 30, 60);
ellipse (230, 160, 30, 60);*/ // 0Ojo derecho

5.2. Funciones setup Yy draw

Cuando ejecutamos un programa en Processing, el c6digo no se ejecuta de arriba a abajo una sola
vez, sino que utiliza un modelo de ejecuciéon basado en dos fases bien diferenciadas: setup () y

draw ().

= Al pulsar el boton , Processing inicia el programa y lo primero que hace es llamar a la funcién
setup ().

= La funcién setup () se ejecuta una tinica vez al comienzo del programa. Su objetivo es
preparar el entorno antes de empezar a dibujar. En esta funcién se suele definir el tamafio
de la ventana, inicializar variables, configurar colores o modos de dibujo y cargar recursos
como imagenes o fuentes. Una vez que setup () termina, Processing no vuelve a ejecutarla.

» Después de setup (), Processing entra autométicamente en la funcién draw (). La funcién
draw() se ejecuta repetidamente, normalmente unas sesenta veces por segundo. En cada
ejecucion se dibuja un nuevo fotograma y se actualizan posiciones o estados. Gracias a
este bucle continuo es posible crear animaciones, juegos y visualizaciones interactivas.

draw() draw() draw()
Iteracion 1 Iteracion 2 Iteracion n

mouth ()

Figura 12: Analogia del funcionamiento de Processing, y el proceso de animacion. El resultado final se compone de
varias llamadas a draw, y en cada llamada, se dibujan multiples tipos de geometria.

14
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El programa comienza

e

Inicializa ventana y
variables

|

setup() termina

|

Dibuja un fotograma

\

’ Actualiza estado ‘

Tanto setup como draw son funciones especiales que no requieren ser llamadas explicitamente
en el c6digo; Processing se encarga de ello autométicamente. Por ahora, s6lo cabe destacar que el
c6digo que se encuentra dentro de una funcién debe estar sangrado (indentado) para indicar
que pertenece a dicha funcion. Ademas, ambas funciones devuelven void, lo que significa que no
devuelven ningtn valor. También es importante abrir y cerrar llaves {} para definir el bloque de
cédigo que pertenece a cada funcién.

Ejercicio 11 - Zoog, utilizando setup y draw

Reescribe el c6digo de Zoog utilizando las funciones setup y draw. (Notas alguna diferencia
en el resultado respecto al c6digo original?

15
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void setup () {
// Tamafo del lienzo
size (600, 600);

void draw() {
// Fondo blanco
background (255) ;

// Coordenadas desde el centro
ellipseMode (CENTER) ;
rectMode (CENTER) ;

// CUERPO
stroke (0) ;
fill(150) ;
rect (200, 260, 50, 260);

// CABEZA
fill (255) ;
ellipse (200, 160, 130, 160);

// 0JOS
fill (0) ;
ellipse (170, 160, 30, 60);
ellipse (230, 160, 30, 60);

// PIERNAS
stroke (0) ;
line (175, 390, 150, 420);
line (226, 390, 250, 420);

Color de fondo

Prueba a mover la instruccién background (255) ; desde la funcién draw a la funcién setup.
(Qué ocurre?

5.3. Interaccion con el raton

En Processing existen algunas palabras reservadas como width y height, que permiten acceder
al ancho y alto de la ventana, respectivamente, y otras que permiten interactuar con el usuario,
como mouseX Yy mouseY, que indican la posicién actual del ratén en la ventana.

Ejercicio 12 - Sigue al ratéon

Modifica el programa de Zoog para que la esquina superior izquierda del cuerpo de Zoog
sea la posicién del ratén, utilizando mousex y mousey.

16
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6 Variables, condicionales y bucles

Ejercicio 13 - Sigue al ratén II

Posiciona la cabeza de Zoog sobre el cuerpo, de acuerdo también a las coordenadas (mousex,
mouseY), de manera que la cabeza se mueva en funcién de la posicién del ratén. Por supuesto,
tendrds que ajustar también la posicién de los ojos.

Ejercicio extra - Sigue al ratén 111

relativa con el cuerpo.

Intenta que las piernas de Zoog también sigan al ratén, manteniendo la misma distancia

160 pt

260 pt

30 pt

130 pt

——

25 pt 50 pt

60 pt

Figura 13: Algunas medidas de Zoog.

6. Variables, condicionales y bucles

6.1. Introduccion a variables

En la seccién anterior hemos descubierto que el método draw se ejecuta de manera repetitiva en
un bucle infinito. Esto nos permite crear programas dinamicos que cambian con el tiempo. Sin
embargo, para crear programas mds complejos, es necesario utilizar variables para almacenar
datos que pueden cambiar durante la ejecuciéon del programa.

17
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Ejercicio 14 - Traslada una esfera

Crea un programa que traslade una esfera de izquierda a derecha en la ventana. Utiliza una
variable para almacenar la posiciéon horizontal de la esfera, y actualizala en cada iteraciéon
del bucle draw.

Solucién:

int circleX

100;
int circleY = 100;

void setup () {
size (400, 200);

void draw () {
background (255) ;
stroke (0) ;
fill (175) ;
ellipse(circleX, circleY, 50, 50);
circleX = circleX + 1;

6.2. Condicionales

Los condicionales permiten ejecutar diferentes bloques de cédigo en funcién de si se cumple o
no una determinada condicién. En Processing, los condicionales se implementan utilizando las
palabras reservadas if, else if y else.

La sintaxis basica de un condicional es la siguiente:

if (condiciédn) {

// bloque de cdédigo si la condicidén es verdadera
} else if (otra_condicidn) {

// bloque de cdédigo si la otra condicidén es verdadera
} else {

// bloque de cdédigo si ninguna condicidén es verdadera

Ten en cuenta que no siempre es necesario utilizar else if 0else;un condicional puede consistir
unicamente en una instruccion if.

Ejercicio 15 - Color de fondo interactivo

Modifica el programa de Zoog para que el color de fondo cambie en funcién de la posicién
del raton. Por ejemplo, si el raton se encuentra en el primer tercio de la ventana, el fondo
debe ser blanco; si estd en el segundo tercio, el fondo debe ser gris; y si estd en el tercer tercio,
el fondo debe ser negro.

Pista: en el c6digo que hemos utilizado para dibujar a Zoog se define una ventana de tamafio
600x600. Puedes comprobar si mousex 0 mousey se encuentran en un determinado tercio de
la pantalla:

18
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if (mouseX < 200) {

else if (...) {

else {

6 Variables, condicionales y bucles

6.3. Bucles

Existen algunas palabras reservadas en Java para representar bucles, es decir, bloques de cédigo
que se repiten durante un niimero de iteraciones, o infinitamente hasta que no se cumpla

alguna condicién.

En esta sesion es suficiente con conocer el bucle for, que permite ejecutar un bloque de c6digo un
nimero determinado de veces. La sintaxis basica de un bucle for es la siguiente:

for (int i = 1; i <= N; i++) {

// bloque de cdédigo a ejecutar N veces

Ejercicio 16 - Mdltiples Zoog

horizontal y vertical en funcién de i:

size (500, 200);

int N = 2;
float offsetX = 0;
float offsetY = 0;

for (int i = 1; i <= N; i++) |
rect (50 + offsetX, 20 + offsetY,

offsetX += 100;
offsetY += 10;

80,

El objetivo es mostrar 2 Zoogs en la pantalla a partir del programa de un tinico Zoog. Ten en
cuenta que tendras que modificar la posicién de al menos uno de ellos para que sea visible.
A modo de inspiracién, el siguiente c6digo dibuja dos rectangulos desplazados en el eje

80) ;

Ejercicio 17 - Z pares de brazos

Modifica el programa de Zoog para que dibuje Z pares de brazos, donde Z es una variable
que puedes definir al principio del programa. Utiliza un bucle for para dibujar los brazos.
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Figura 14: Resultado de anadir 3 pares de brazos a Zoog.

Apéndice: Instalacion de Processing

J) Processing Download Documentation Learn Forum About Donate Search »

Welcome to Processing!

Processing is a flexible software sketchbook and a language for learning how to code.
Since 2001, Processing has promoted software literacy within the visual arts and visual
literacy within technology. There are tens of thousands of students, artists, designers,
researchers, and hobbyists who use Processing for learning and prototyping.

Figura 15: Banner de la pagina oficial de Processing; a la izquierda se muestra el botdn de Download.

= Accede a la pagina oficial de Processing y selecciona Download.
= Descarga la versién correspondiente a tu sistema operativo.
» Ejecuta el instalador descargado y sigue las instrucciones.
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